Thanks to our system users for these suggestions!
2020
Version 10.20 (October)
Modified Payroll Benefits module, Four Utility Modules and added two new reports.
Added function to Inventory Audit (From Main Toolbar => Utilities => DataBase Tools => Inventory Basis
(Audit) => Reconcile UP TO date. This enables you to temporarily "back down" Inventory balances to a Previous
Date and run Inventory Reports as of that date. Be sure to recalc to Current date so Inventory Balances are
Current.
Version 10.19 (September)
Added new module to Equipment Preventive Maintenance, providing a complete look at All Equipment and All
PM's at one look. To run it go to/open . . . Fleet Managemnt => Equipment => All PM's button. Improved Work
Order module performance which will require a one-time-automatic-update when first that module, or others
associated with it are accessed.
Version 10.18 (August)
Added interface to Work Orders. Everything works the same; i.e., create the Open Work Order (OWO), then
in Cost Accounting go to that Worker Order (column sort of W/O), highlight and copy it and modify it to the
employee, equipment, material, etc. to make first entry on Work Order and close to, for instance, Driveways-2020,
or whatever. Copy open Work Order to add more line items, edit employee, equipment, material, etc. Continue.
To Close W/O got to the Open W/O and charge it to the appropriate Project (Driveways-2020), or whatever.
To bill a citizen for work done under a Work Order, open Reporting => Report Manager => and search for Order
or Select and move Select W.O. for Billing to the 3rd window so you don't have to Search for it next time you
want to run it. Other Work Order Analysis Reports are in the Work Order Module.
Version 10.17 (July)
Rewrite of Inventory Transfer module as random posting errors began to show up . . . Module was written around
10 years ago so keeping up with MicroSoft Updates is a must and can sometimes create "issues".
Version 10.17 (June)
Added 2 new generic reports, optimized one report and optimized 2 modules and overall system for faster startup.
Added filter to Cash Receipts module so you can see each Fiscal Year by itself versus all receipts.
Version 10.16 (June)
If you write a report with the built in Report Writer using the Bridge Table the Sufficiency Rating in Browse
Window is labeled correctly, but you need to change its column heading on your report. Select the FASRoute
field (which is the sufficiency rating) and then the Advanced Button to change the column heading to Suf
Rating, or whatever you want it to be. Once you make this modification the report will be saved with change(s)
so you don't have to do it again.
Version 10.16 (May)
Added checkbox to Purchase (Non-Inventory and Inventory) which can be used when you audit the transaction,
compare it to another city/county authority (county auditor, etc.). You can also use this switch in the Filter Box
to subset those records (A) Audited or Not Audited (X). Added Audit report to print those records audited or notaudited. Name: PurchaseAudit. In Report Manager search for Audit.
Version 10.16 (March)
Added 4 generic reports and tuned up FEMA Reports that were written 10 years ago as some requirements
changed. Also updated FEMA Equipment Table from last years update.
Version 10.16 (January)
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Modified Sign Lookup in C/A so you can enter Purchase/Install Date with Left-Double-Click, then enter data (if
you want to) and Click Select or Enter Key twice to save entered data and select that particular sign for C/A.
2019
Version 10.16 (September - December)
Added 5 new reports. Moved application to faster data engine for faster user response and reporting. Fixed
random bug, found during advanced stress testing, in Inventory Transfer Module.
Version 10.15 (July-August)
Added 2 new reports. Added new utility for updating end of year equipment meter (Miles/Hours) readings. It's
located, from the Main Toolbar => Utilities => Fiscal Year End Wizards => Set Meter button.
Modified Budget/Fund Analysis to make it easier to analyze different Fiscal Years.
Version 10.14 (June)
Added Filter and Export function to Maintenance Cost in Equipment Table. Added Sign, Culvert and Other Asset
lookup to Fund Accounting.
Added automatic FEMA Rate updater which ONLY Works after you have assigned correct FEMA Code to your
equipment . . . . it's primary use is to update current FEMA rates from previous years FEMA rates. It's accessed
on the Utilities => DataBase Tools => Auto FEMA Rates button.
Version 10.13 (January - February - March - April - May)
Added PUP lookup for secondary equipment; i.e., trailer, spreader, etc.
Added and/or modified 5 State Specific reports and 3 Generic Reports. Optimized 4 primary modules.
Added Lat/Lng to All Assets Browse - you may need to Format your Browse to include these new columns - - if
so, point mouse at Browse Window => Right Click => List Formats => Format Setups => Delete All => Yes=>
Close. This work on any Browse that may have lost focus.

**** If you encounter a Parsing error when doing a Google Earth Lookup (in Bridges, Complaints and Signs

tables) it's because you have an ampersand & in your Road field. To correct it use the Filter Browse and filter
by Road Contains & and Apply button. Then remove the ampersand from each Road field. Also, be sure
that your Longitude is a negative as the Western Hemisphere is West of the Prime Meridian; i.e., North and South
America and other locales in that region.
2018
Version 10.12 (September)
Added 4 new reports. Optimized 6 modules and submodules.
Version 10.11 (July) Version 10.12
Added Printer Selector on ToolBar which works the same a Printer Selector in Report Manager but is more
convenient.
When using Report Writer to write your own reports, it defaults to the Printer you have set when R&B IMS(r)
starts so, if in program and you want your Report Writer Report to go to a different printer than current Default,
Select Printer, then exit R&B IMS(r) and when you restart the Default Printer you selected will be installed.
Added Printer Selector to the Complaints Browse for printing single record.
Version 10.11 (June)
Tightened updating security of edits for existing purchases
Version 10.11 (March)
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Non Inventory and Inventory

Added 5 new reports. Optimized several modules for faster startup and processing including new Report
Manager.
Version 10.10 (January)
Added sub-module to Other Assets for Water Distribution Assets and implemented 3rd Memory Browse in
Report Manager. Added 5 new reports and modified 6 others. Corrected Audit totaling errors in the new Inventory
Audit module. If you've run it before it would be a good idea to Audit/Re-Balance your Inventory again. Our
Inventory is Perpetual so it summarizes all historical Purchases, Usage, Transfers and Inventory Adjustments in
both Purchasing Modules (Purchase Lite and Complete Accounting) as well as usage via Cost Accounting and
Fleet Management.
Modifed Report Manager to include a "Remember" Browse which you control and will "remember" what reports
have been run so you don't have to do a "Search-for-Report" when running reports.
Increased memo in All Assets (Roads) table to hold 8,000 character.
2017
Version 10.010 (September)
Added 4 new state specific reports and 5 new generic reports.
Version 10.09 (July)
Added .pdf lookup to Cost Accounting records (naming convention: record #.pdf), 4 Generic and 3 State Specific
Reports, optimized four modules and cleared issue with a report not executing from Win drop downs.
Version 10.08 (April)
This marks the first Quarterly update as we have been doing monthly updates for the past 15+ years.
This update includes the new Nebraska One-and-Six-Year reporting suite, optimizations of several modules, 12
new State Specific Reports. Added Transaction Info for filters on Fund Accounting - be sure to use the "Contains"
Operator when searching Transaction field as it contains data that can be anywhere in that field.
Added ability to subset Signs by 'Installed by' data field so you can group signs by whatever criteria; i.e., NOT
pull up all signs when creating KML/GPS file to run under Google Earth.
Tweaked Nebraska specific reporting to specifications.
Version 10.07 (February)
Added 200+ new fields for the new Nebraska state report suite which will require an automatic update when you
open the Projects Module, and depending when you last updated may automatically update other modules as there
have been several architecture modifications over the past few months.
The new Nebraska Reports added 3 tabs to Projects Module and Additiona Revenue Breakout in the Revenue
(Sources) module.
2016
Version 10.06 (December)
Added five state specific reports and modified one. Optimized 4 modules. Didn't make the planned enhnacement
to the Quickest Menu, yet. It will keep track of the five most recently used modules making it easier to go back to
the module you were most recently working in.
Version 10.05 (November)
Added three state specific reports and modified two others. Corrected several windows placements and visual
modes. Optimized 2 modules. Next month we plan to add an enhnacement to the Quickest Menu that will keep
track of the five most recently used modules making it easier to go back to the module you were most recently
working in.
Version 10.04 (October)
Added two state specific reports, a timesaving shortcut for reconciling inventory with Physical Inventory Counts,
modified Cost Accounting Browse and Shop Work Order Module to preserve previous meter reading and date and
added 3 generic reports.
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Version 10.03 (September)
Modified one state report, added two generic reports, fixed a couple of minor latent bugs which came to life
during the Version upgrade.
Version 10.02 (August)
Added two State Specific reports and modified 3 others.
Version 10.01 (July)
Rolled in many modifications that did not make the trip to Version 10 correctly. The goal for Version 10 is to
make it work (exactly) like Version 9, but have a faster engine, optimized modules, new module and report
lookups and drag-and-drop filters (searches) on most often used Browse Windows
Version 10.00 (June)
Version 10 includes Faster Software Engine and optimized modules, Module and Reports Search, .PDF or default
printer selector for all reports in Report Manager, left-double-click or highlight and ENTER to select from
Quickest Menu, New Drag & Drop or Manual Entry Data Filter, New Report Writer, more easily accessible
'SendTo' folder, user preference setup for Main Frame background and further explanation of added functionality,
from Main Frame -> ToolBar -> button "V10".
For further information check, from Main ToolBar -> Help -> V10 - New Functioality
Version 9.37 (April & May)
Added two new State reports and modified/updated two more.
Version 10.0 (April) [We missed this date :) . . . should be released June]
Version 10 includes Faster Software Engine and optimized modules, Module and Reports Search, .PDF, leftdouble-click select from Quickest Menu, New Drag & Drop or Manual Entry Data Filter, New Report Writer,
more easily accessible 'SendTo' folder, user preference setup for Main Frame background and further explanation
of added functionality, from Main Frame -> ToolBar -> button "V10".
Version 9.36 (March)
Added one new State report.
Version 10 will be released April 4th. It includes Search capability for Modules (150+) and Reports (400+)
Selection with .pdf generator, new Report Writer so you can write your own Reports for Cost and Fund
Accounting and Asset Management Modules, a new, faster software engine and further optimization of all
modules.
The new release will include a .pdf manual explaining how new functionality works and how it will save you
keystrokes, search time (finding that Report and/or Module) and provide more information at your fingertips.
Version 9.35 (December/January/February)
Added a keep alive for those who are using our Cloud Server and are on Cell and/or WiFi connection. The check
box to turn iT on or off is Top Center of the Main ToolBar.
This has been added to create a constant stream of data which, we think, is why your Cell or WiFi connection
drops occasionally. When the image flips over a screen update is sent from our Server to your Desktop, thus
generating a tiny screen update when your computer is otherwise idle . . .
Cell connections are notorious for dropping off if the connection does not have a regular flow of data.
PLEASE LET US KNOW IF THIS IMPROVES YOUR CELL CONNECTIVITY.
2015
Version 9.34 (November)
Optimized Cost Accounting Allocator. This module (2009) can be used, for instance, if you have one person
inspect 12 roads in one day. The allocation for their labor and equipment can be based on square foot or length of
the road.
Added 2 new state reports.
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Version 9.33 (October)
Added "Last Service Date" to Equipment Browse, 3 new State Specific Reports and optimized 3 modules.
Version 9.32 (September)
Modified 4 generic reports, added one new State report. Added View Only Equipment Browse and Form for other
departments use.
Optimized 3 modules for faster startup.
Version 9.31 (August)
Added Employee cost update for Cost Accounting records in selected date range. Primarily, for correcting past
entries when Pay Rate was incorrect. It's located at Utilities -> Database Tools -> Update Employee Pay.
Added TABbing functionality to Employee Table.
Optimized Cost Accounting module.
Version 9.30 (July)
Optimized load time for Shop Work Order and Permits Module. Added 2 new state specific reports and modified 4
generic reports.
Version 9.29 (June)
Added 3 state reports and modified 2, optimized load time on Complaints and Equipment module.
Version 9.28 (May)
Finally gave up on MS IE 11 as the Browser for Google(r) Maps. Every releases of MS IE(r) since version 8 has
broken something in our interface so rather than keep dealing with their "enhancements" we have now interfaced
our map lookups directly to Google(r) via their Browser (5/8/15).
You will need to install the free Google Chrome(r) in default location. If you're running R&B IMS(r) on our Cloud
Server Browser is already installed.
Free Google Chrome(r) can be downloaded at: https://www.google.com/chrome/browser/desktop/index.html
Added switch on Cost Accounting Browse to enable Tabbing from Regular Hours to OT Hours, otherwise (not
checked) Tabbing goes from Regular Hours to Total Labor Cost.
Around 15% of records entered to Cost Accounting (hours worked) have OT hours included which was the reason
for adding this switch.
Added 2 new state reports and modified 3 other reports.
Corrected Inventory Transfers posting error and related Transfers report.
Version 9.27 (April)
Added 4 State Specific Reports, modified title of 5 other Reports and optimized load time of Complaints module.
Version 9.26 (March)
Modified 2 State Reports. Added Units column to Cost Accounting Browse.
Version 9.25 (February)
Modified key and relation to speed up Projects 'Detail Cost Analysis' Browse Window. Added one new state report
and modified 3 generic reports.
We're planning to release R&B IMS(r) Version 10 on March 31st, possibly sooner as we're currently in semifinal test phase. Version 10 will have a fully integrated report writer and we will continue creating more complex
reports as part of overall Support Package.
Version 9.24 (January)
Added ability to charge Call Back time worked and either add cost to total labor or not charge for Call Back time.
2014
Version 9.23 (December)
Speeded up Cost Accounting Entry by resetting and shortening TAB sequence. Added 2 new State Reports.
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Version 9.22 (November)
Corrected a random posting issue in Fleet Management Module and optimized Browse scrolling by making
second and third Browses User selectable.
Version 9.21 (October)
Wrote 2 new state reports and optimized 3 Modules.
Version 9.20 (September)
Optimized Startup Time, Shop W/O Modules and 2 reports, added 3 new reports.
Version 9.19 (August)
Added interface to daily data backups for Web-based users (From Main ToolBar -> Utilities -> Database Tools ->
Web Back-Ups.
Increased field size to 35 characters for Material Number and 20 characters for Material Description fields on
Fleet Management (Shop Work Orders) and modified Shop W/O reports.
Added Vendor Name to Purchase Browses.
Version 9.18 (July)
Added 2 new state reports, optimized open and run time for 3 modules.
Version 10 didn't make the July publish date as we decided it needed more testing by users. We plan on publishing
it to our Demo Cloud Server by the end of July and will provide software connectors to any who have interest in
running it.
Version 10 will have the familiar interface of Road & Bridge(r) and the "ease of use" of some Microsoft(r)
products; i.e., similar to Outlook(r), etc.
Version 10 needs additional "horsepower" (CPU and Disk) so we're planning to keep Version 10 on our Cloudbased Server; i.e., not run on local DeskTop and/or your Local server.
Version 9 (our current version) will continue to be supported for many years into the future.
Version 9.17 (June)
Added auto update in Non-Inventory Purchases (Fund Accounting (Lite)) to post Material Description to
Transaction Info field.
Version 9.16 (May)
Added filter to Cost Accounting Equipment Lookup to filter out equipment marked as SOLD in Remarks Field
(on Equipment Record). Added 2 new State Reports and modified 3 Generic Reports.
Don't forget - Version 10 will be available (at no additional cost) for all users who have current Software Support,
July 1.
Version 9.15 (April)
R&B IMS(r) Version 10 will be released July 1st. It has a completely new look (similar to MS OutLook(r)),
several more optimized modules and new interface to Google Maps(r).
This is a no-cost update for all current users.
Added Other Assets Utility, optimized 4 modules, added 3 new State Reports and modified 1 State Report.
Version 9.14 (March)
Tweaked Send To export to work with Excel 2013 and added three new State reports.
Version 9.13 (February)
Updated Send To process to a newer COM (Component Object Model) to speed up exports to ExcelÂ®. Added 3
State Specific reports.
Version 9.12 (January)
Corrected TAB sequence issue in Cost Accounting input window.
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2013
Version 9.11 (December)
Optimized several modules and added or modified 4 state specific reports.
Next month (January, 2014) Version 10 of Visual R&B IMS(r). This version will have the same functionality and
will have a "Windows-Style" presentation layer.
This is a no cost upgrade for all users with Software Support Policies in force.
Version 9.10 (November)
Added 2 new state specific reports and optimized startup times of 5 modules.
Version 9.09 (October)
For a User Security Level of Less Than 5, Set to Read-Only the following modules: All Assets, Bridges,
Complaints, Equipment, Estimator, Fleet Managment, Other Assets, Projects, Signs, Vendors, Warranty and added
two new generic reports.
Version 9.08 (September)
Added two new State Specific reports.
Version 9.07 (August)
Added secondary equipment automatic record (for piece of equipment attached to primary equipment) on Cost
Accounting entry record. This will record same hours/miles on attached Pup, mower, blade, etc. as on primary
equipment.
Attached equipment can only be added to New Records (not previously entered records).
To Edit attached piece of equipment (after attached to primary record) click on Memo & Attached Eqp TAB, edit
as a spread sheet cell.
Version 9.06 (July)
Added Bridge lookup on direct charged Fund Accounting screen. Added 2 new State Specific reports.
Version 9.05 (June)
Increased Latitude/Longitude from 4 to 6 decimal point accuracy on Bridges, Culverts, Signs and Permits. You
need to run a one-time-only update if you have Bridges, Culverts or Sign data previously collected
The utility is located, from Main Tool-Bar -> Utilities -> Database Tools -> 6-Decimal Lat/Lng.
If you also use this data to drive a data layer in ArcInfo(r), MapInfo(r), or other GIS Application, the other button
Update GIS Data will convert the Data to .dbf format and rename files to Signsdbf.dbf, Culvertdbf.dbf and
Bridgedbf.dbf.
Updated 50+ reports and added one new State Report.
Added memo field to Vendors Browse.
2013

Version 9.04 (May)
Added Live Audit for Cost Accounting entries; i.e., audit your data entry at time of entry. Added 2 new State
Specific reports. Changed road/street lookups to default to your Road/Street table (all Assets), with option to
check box and lookup in deprecated GIS data table.
Version 9.03 (April)
Added phone numbers (2) to Employee Browse, 3 new State Specific Reports, Hall County F/A button and Road
# to C/A Road Lookup.
Version 9.02 (March)
Added department name and license plate number to Equipment Browse. Added 2 new state specific reports.
Optimized Startup speed.
Version 9.01 (February)
Added Call Back hours (Cost Accounting) and report. Added Inventory Lookups to Equipment components
description for check inventory levels when viewing, for instance, particular Filters, etc. (primarily for planning
Preventive Maintenance scheduling).
Version 9.00 (January)
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Visual R&B IMS(r) is now both desktop/network AND Cloud-based. Both applications run the same and have
the same functionality. The advantage of Cloud-based is you don't have to worry about backups or Server
management - - - we do it all. All you need is some sort of computing device (desktop, laptop, tablet, most
handhelds), an internet connection (anywhere in the office or in the field) and a printer, for hard copy reports.
The new Click-It! Report Writer provides much easier to use and faster report development . . . . and reports can
be written by selecting options from menus, versus writing queries and/or moving fields around on a screen. The
ClickIt! Report Writer, runs just like its name.
Added Complaints Ref Num to query field selections and Emergency Call Our Hours to Cost Accounting for
documenting those hours, generally after normal working hours, when crew members are called out and their
hours are reimbursable by a third party (FEMA, State, etc.) entity.
2012

Version 8.99 (December)
Added 2 new State Specific Reports and a System Check and Set Utility.
Next month we will have a new, easier to use, built-in Report Writer. All your reports in MyReports2 library will
still be supported and maintained. Also, January 2nd our Cloud-based Visual R&B IMS(r) that operates the
same, but eliminates the need for local data management, file backups and Updating will be available to testdrive.
Cloud-based means your data is accessible nearly anywhere by nearly any device (desktop, laptop, hand held,
etc.) with internet access and that you provide permission to.
We will continue to support current Destop/Network systems and monthly updates will continue.
If you would like to test-drive the Cloud-based version send us an EMail for access and password.
Version 8.98 (November)
Moved record posting operation into separate process in Fleet Management Detail Shop Work Order module.
Added 3 new state reports.
Version 8.97 (October)
Added 2 new State Specific Reports, functions to post full employee name from Shop Work Orders to Cost
Accounting and .pdf view of Invoice when a Direct Purchase is made.
Version 8.96 (September)
Updated FEAMA Equipment Rates Table and added one new State Specific report and modified a couple of data
bindings which threw occasional random data errors.
Version 8.95 (August)
Added 2 new State Reports and modified Shop Work Order Report by adding memo capability.
Re-Factored Fleet Management Shop Work Order Module to correct a strange anomaly that was showing up on
a WIN7 64-bit machine.
Version 8.94 (July)
Added 4 'S' buttons (Select Print) to the Work Order Browse - - these buttons print directly to your Default Printer
instead of invoking Windows(r) Printer Selector API.
Version 8.93 (June)
Modified overtime rate calc; if you record overtime worked hours and do not enter the rate, when record is OK'ed
it assumes a 1.5 OT Rate . . . unless you check box to right of OT Rate field (do not calc dollars on OT hours
worked). Added 2 state reports and 3 generic reports.
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In June we start the process (which will take around one year) of rewriting the application so it will run entirely in
your Web Browser and all data will be saved and backed up daily . . . automatically. Moving the application to
the "Cloud" enables more flexible use and access for your data from various other computing platforms, as well
as lessen the work load on your IT group.
We will continue to support the current desktop/network application for several years and do not
intend to increase the annual software support and maintenance cost from the current rate to everyone
currently running our application.
We anticipate no additional charges, maintaining the current software maintenance and support costs
and passing the development costs for the Cloud-Based version to future users.
We will also develop a utility to move your Fixed Asset Data (Roads, Bridges, Culverts, Signs, Other Assets)
and Current (non-Fixed) Assets (Equipment, Employees, General Ledger and Budget, Flood Plain Management,
Scheduling, Projects, Entity, Service Types, Tasks, Departments, Officials, Subdivisions and R/S Surfaces) to the
Cloud-Based system. The new system will run very similarly to the current version.
This Move to the Cloud is being made by most leading software companies as the web has become much more
application- friendly over the past couple of years - - the Cloud is the future of computing, freeing users from
specific hardware requirements and eliminating the need for other costly applications - - all you need is a Browser
and internet connection. Security is built in from the ground up.
For those who want to maintain their own data, in the new Cloud based application, a locally installed and
maintained Cloud version will be available that will let you run the Server locally, but there will be additional costs
involved (Server, Data Engine, etc.).
The best time to move your operations from the desktop/network Visual R&B IMS(r) application to the Cloudbased application, would be at the beginning of your Fiscal Year. We forecast the Cloud-based application will be
ready in one year (June 2013) as development will be quite developer intensive.
We plan to have demo versions available (web browser access only) in the next 6 to 8 months.
Version 8.92 (May)
Added 3 reports, solved incompatibility issue with an anti-virus software and added utility enhancement (speed
up).
Version 8.91 (April)
Added 2 State specific reports and 3 generic reports. Optimized load and run times for anti-virus vendors and
Windows(r) updates.
Version 8.90 (March)
Added utilities for making macro changes to Signs, Equipment, Roads/Streets and an Accounts Receivable
module.
Version 8.89 (February)
Added 'Print to Default Printer' button to Complaints Browse, added utility to reclassify Road/Street Names and
added 4 new state reports.
Version 8.88 (January)
Added 1 new state report. Optimized program startup. Program startup when running on local drive should take
2-4 seconds and across nework should take 4-8 seconds. For faster program startup time, exclude your antivirus
from scanning the Road & Bridge folders - which also enables Road & Bridge to run 2 to 10 times faster.
2011

Version 8.87 (December)
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Added 3 new State Reports, optimized Fuel Efficiency Calculator and Google(r) interfaces. Added single record
print button to Sign record. Reformatted Culvert List Report and added Send functions to Bridges, Culverts,
Signs and Other Assets Maintenance History Tab Browses.
Version 8.86 (November)
Optimized 2 Budget to Actual Spending reports. Added 4 new State Specific reports. Optimized application load
time.
Version 8.85 (October)
Added 3 new state specific reports, optimized Google(r) interfaces and built-in browser interfaces.
Version 8.84 (September)
Moved automatic File Schema Updater so it would run after a Web Update if needed. This utility change is done
to increase file access performance - - the previous utility checked each file immediately before it was opened
which took a few CPU cycles and added a few milliseconds for file opening.
This automatic updating utility will add a few seconds runtime only when performing a WebUpdate.
After Running downloaded Update these screens will be the next you see. They confirm that all File Schemas
have been automatically updated. Normally, you click he Quit Now button to close, then start Visual R&B IMS(r)
from your desktop ICON. The built-in File Recovery Utility is still under the Utilities menu, if needed.

Added record filters to Signs and Bridges Browse for projecting record subsets to Google(r) Earth.
Added 4 new state reports and custom modifications for a city installation. As Microsoft(r) security updates and
anti-virus vendors update their libraries it becomes more important to exclude your Road & Bridge folders from
anti-virus scans to keep system running at optimum performance levels.
Version 8.83 (August)
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Added O/S G/L number (Outside Service/Equipment Special Service General Ledger A/C Number) to Cost
Accounting Browse.
Instituted alternative file opening/closing routine which will improve performance. Added 2 new State Specific
reports and 3 new generic reports.
Version 8.82 (July)
Fixed button display issue in Fund Accounting module.
Updated Cemetery report library - we had a blowout on a report ☺
Added 3 new State specific reports. Added Task Code to Projects Analysis browse.
Version 8.81 (June)
Modified interface to Entity data store.
Added Send To option to Fleet Management Detail line items so user can subset by Equipment Number, Work
Order Number, etc. and export detail line items in .pdf, .html, .xls(x), .doc or .csv format. Added a static variable
for hours worked but cost not accumulated in Cost Accounting record. Added 4 new state specific reports.
Version 8.80 (May)
Added 'By Project By Task Summary Level' Report. Added 'Post Condition' to Sign Query. Modified Fleet
Management Shop Work Order Master record so 'Update Meter & Date' box will be automatically checked when
a 'PM box' is checked. Added one State Specific Report.
Version 8.79 (April)
Added 7 new state reports, optimized cost record allocation module, added to MUTCD sign image library and
optimized interface to Google Maps® and Google Earth®.
Version 8.78 (March)
Added 4 new state reports, optimized WFP module and updated web site (recorded webinars are added each
month as well as normal ongoing maintenance).
Version 8.77 (February)
Optimized start up procedure - took a second or two off startup time. Startup on local computer should be 2 to
7+ seconds depending on local CPU, antivirus status (exclude Road & Bridge folder and sub folders for fastest
operations) and other tasks running at time of startup. If starting over a network, network speed is primary
determination of startup time.
Version 8.76 (January)
A new Cost Record Allocation module for allocation of a cost record over (1) multiple roads/streets or (2) road/
street surface square footage or (3) by road/street length is accessed from the Cost Accounting Browse window.
This module enables you to easily allocate costs to many road/street working areas with one entry.
The Cost Record Allocation is a memory resident module (for speed/efficiency). If you modify a Road/Street
Record (All Assets) record, in order to refresh the memory resident module you will need to exit R&B IMS and
restart it - this re-loads the memory resident Allocation Module with your new data. This only needs to be done if
you modify the Length or Surface Area of any road or street.
Updated code to comply with Google Earth® version 6. To look up any latitude - longitude location in Browser,
(1) left double-click mouse to drill down, (2) click one time on asset location (3) click the 'Link' button (upper right
of map window), (4) click 'Copy' ICON (upper right on ToolBar. To embed latitude - longitude in Visual R&B IMS®
record click the Google® Latitude/Longitude button.
2010

Version 8.75 (December)
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Added a Global Blanket Purchase Order control for both Complete and Lite Fund Accounting. The original
Vendor Specific Blanket Purchase Orders is also still in effect so you have two Blanket Purchase Order systems.
To access Global Blanket Purchase Order (from Main ToolBar -> Menus -> Functional Menu -> Setup TAB- ->
Blanket P.O. button.
Version 8.74 (November)
Added View .pdf button for All Assets records so you may save either pictures (View Pics) or .pdf documents
related to Road/Street name. PDFf's and/or pictures (any format) are saved to the Roads folder, under the
Images folder which is under the DATA folder. (main R&B folder\DATA\Images\Roads). All webinars have been
converted from .mp4 to .swf (Flash®) format and are available on website for viewing at anytime.
Added View .pdf button on Fund Accounting Lite Records. Lookup (.pdf) file name is the Claim/P/O # for
the record. If you have multiple documents for same P.O. # then add a -1, -2, -3, date or other attribute to
differentiate each document.
Version 8.73 (October)
Integrated a light-weight (fast) browser for viewing training videos on our web site. Access to web videos is no
longer from Browse windows - please use our browser (from Main Menu -> Help -> CompuLink's WebSite).
Added new equipment reports and optimized several modules.
Version 8.72 (September)
Added 3 new state specific reports. Optimized Permits module.
Added 6 .png MUTCD signs to Website for lookups via Google® Earth. Converted Webinar videos from Citrix®
"private" video format to Adobe® .swf format which will provide streaming video download performance.
You may need to add "streaming video" awareness if you run Microsoft® Internet browser - its native in (free)
Google® Chrome browser.
Interim release: Removed Spell Checking from application as it was causing problems in the Equipment module
Version 8.71 (August)
Added 3 new state reports, optimized several modules and Fleet Management Browse lookup.
We maxed out server space provided by Citrix(r) so moved all videos to our web site. You may need to install a
free .mp4 compatible viewer - - if so, just follow the instructions provided by MicroSoft(r).
After converting all videos to .mp4 we realized that Microsoft(r) Internet Explorer was not fast enough (we've
been using Google(r) Chrome for over a year and it is very fast and stable) for viewing .mp4 video. So, we
converted all videos to Adobe® Flash which is much faster (nearly instant with Google(r) Chrome). After this we
realized that Internet Explorer doesn't understand Adobe(r) Flash streaming video . . . . .
So, in order to speed up MicroSoft(r) Internet Explorer for viewing Adobe(r) Flash videos (in streaming mode) you
need to add (if desired and cleared with your IT department) FlashCatch(r) from http://www.flashcatch.com/
This free utility speeds up viewing of our Adobe(r) Flash videos in Internet Explorer®. Google(r) Chrome is still
magnitudes faster.
When pressing the Video button on a Browse window or when using the CompuLink's Website button (from Help
button on Main ToolBar) Internet Explorer is invoked as it's assumed most all installs have "the lowest common
denominator" browser installed.
Version 8.70 (July)
Added 'B' (Break Time/Lunch, etc) to Comp Codes so time not worked can be accounted for - this time earns no
pay. Added report to Idaho state library for auditing any Comp Code over any date range.
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Added additional descriptive attribute fields to Equipment file, 2 Equipment reports (Equipment List - Complete
and Details) and new multi-function browse to Fleet Management module. Equipment table will perform
automatic update to synchronize new your Equipment file to the new schema the first time its opened.
Added 4 new state specific reports.
Version 8.69 (June)
Added sign images to Google Earth® lookup. To utilize them (using the Google All® button on Sign Browse) you
need latitude/longitude of the sign, the MUTCD sign type fields populated and the free Google Earth® installed.
Converted the Send To process to a COM (Component Object Model) which will increase the speed and stability
of sending data to Excel® and Word®. Added 6 new State Specific reports.
Version 8.68 (May)
Added 4 new (generic) Reports and 3 new State Specific Reports. Optimized Cost Accounting record update
form and Scheduling module.
Version 8.67 (April)
Added Cemetery Management Module (from the Quickest MEnu -> press 'C' a couple of time -> ENTER key). If
you have existing data we can convert it.
Version 8.66 (March)
Optimized Cost Accounting Browse and entry form. Optimized Benefits Module and added other functionality
(max accumulated hours and threshold levels). Added 4 new state specific reports.
Next month we plan to add MUTCD sign images to the Google® lookup interface; i.e., when doing a sign lookup
via Google®, the appropriate MUTCD sign image will be displayed in lookup window.
Version 8.65 (February)

Added filter to Google® lookup on Service Request/Complaints Browse window. Re-write Google® lookups on Bridges, Culverts and
Signs Browses (using Google® Earth) and optimized Google® lookups on ALL Bridges, Culverts and Signs to include additional screen
information.

Version 8.64 (January)

Added 11 new state reports. Added switch to turn on/off automatic calculations when adding Cost Accounting Records. The AutoCalc
function totals hours previously worked in current work week so you know the status of employees just prior to entering a new work record.
Turning off the AutoCalc (check box on Cost Accounting Browse window NOT checked) saves a few milliseconds when creating a new
work record and also cuts down network traffic - if on a network).
Added switch to Employee Benefits calculator to calculate benefits earned on all hours worked (including benefit hours used). This
enables calculator to work on either this basis, or calculate only on actual hours worked in payroll period.
Anti-Virus vendors keep adding more "functionality" to their applications (anti-virus, anti-spyware, anti-rootkit, anti-span, anti-banner,
firewall, EMail scanning, web shield, resident manager, etc - depending on the software you're running) - which is good because there are
so many bugs on the internet.
The down side to so many 'anti-' functions is they use more and more of your CPU and disk resources which then interrupts your
accomplishment of work with normal programs, such as Visual R&B IMS®.
Another downside, and very salient point, is that relational software systems; i.e., Visual R&B IMS® access, read and write many data
tables when the OK button is clicked, or lookups are performed (often over a dozen with just one OK).

If possible, always exclude the *.TPS files in the DATA folder, or Pause anti-virus scans of the Visual R&B IMS® folders when working with
Visual R&B IMS®. Depending on the anti-virus you may be running, excluding scans can increase execution speed to the 100 fold (100
times faster) range - a very, very large decrease in time it takes to lookup and save records, run reports, etc.
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Recent testing with Visual R&B IMS® with a few of the latest anti-virus packages, has shown over a hundred fold (100X faster) speed
increase when the anti-virus software is either excluded and/or paused (turned off).
Also, if possible, do a full or limited scan (depending on anti-virus vendors options) at night to keep anti-virus from hogging your computer,
server and network bandwidth during the day.
2009

Version 8.63 (December)

Added City subset to E911 Data Management. Corrected and added functionality to one report which was not doing what is was
supposed to be doing :)
Added Google® Earth lookups to Bridges, Culverts and Signs tables. In order to utilize this functionality you will need to have Google®
Earth installed in the default location on your data server (or local computer if dataset is local). Google® Earth is free and can be
downloaded at: http://earth.google.com/download-earth.html
The built-in GIS and its functionality is still available, form the Main ToolBar -> GIS -> Geographic Information Systems -> Built-in GIS and
Google® Earth and the data conversion utility are is also available in the bottom section of that page form.

Version 8.62 (November)

Added E911 Data Management to existing Flood Plain Management module functionality and integrated with GIS for data lookups.
Optimized Google Earth® views under (from main ToolBar -> GIS -> Geographic Information Systems and added interface to GPS data
converter (convert from any GPS data format to any other data format).
Added field to Fleet Maintenance to collect further information on Outside Services. Enhanced Flood Plain module to include E911
management and reporting.
Modified Payroll report to include comp hours earned and used in bi-weekly payroll report. Added additional Security to ftpdownload so it
requires installing it from our website or call us and we can EMail it to you.
Added interface to a different Latitude/Longitude lookup tool in Google Maps®. For determining the Latitude and Longitude of any
location install the "GPS Location" applet. When using, highlight and copy the Latitude and Longitude GPS: 34.35024, -89.89945

to Windows Clipboard, then use the button to embed it Visual R&B IMS® attribute fields - the alternate is typing
Latitude and Longitude manually.
Added Video Help to several modules - - Video button on Browse windows. These are videos that originate with our weekly Webinars
which will cover all modules and functions (over 150), sequentially.
Added six new State Specific reports and modified one Wok Order report.

Version 8.61 (October)

Added Work Hours Analysis button on Cost Accounting entry form. It provides an instant recap of hours worked and comp time "for the
work week of the cost accounting record you have opened".
Removed Splash Screen revolving image to save 1 to 2 seconds when loading system across a network - startup time won't be noticeable
when running from local disk.
Modified filters on 3 'Used By Date . . ." reports, under Inventory - Materials category in Report Manager.
Changed access on Quickest Menu from double-click to 'highlght module and Press ENTER key". First character of module name is 'hot'
which means you can access modules not in the default browse by pressing the first character of module name - repeatedly pressing
the same key walks through successive modules that start with that alphabetic character. When the Quickest menu has focus, pressing
SpaceBar moves to the top of module listing; i.e., the most often used modules.

Version 8.60 (September)

Added Alternate Road/Street name to Subdivisions browse lookup (from All Assets Browse -> Classifications -> By Subdivision -> Select a
Subdivision -> Road/Streets TAB).
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This update finally put the file access bug to rest. The problem (recapped below in Version 8.59a, b, c, d and e, was caused by a
combination of specific antivirus's and Windows® security update(s) and occurred only a few systems.
Removed mouse-left-double-click from Quickest Menu. Randomly, a mouse-left-double-click would cause system to try to open two
sessions of the selected module which would, randomly, cause Visual R&B IMS® to lock up.
To select a module, make sure Quickest menu has focus (mouse-left-click on it), press the first alphabetic character (keyboard) until
module you want is highlighted, then press ENTER key to select. All other menus operate the same as always.

Version 8.59a,b,c,d,e (August)

We've ran into a file access problem which is probably caused by one or two versions of antivirus and showed up on one county running
MicroSoft® Terminal Server on a wireless network, one city running a standard Windows 2003 Server and one county with a Windows®
XP that had been moved from an older computer to a new computer.
Added overtime hours worked to Cost Accounting browse and Equipment Hours at Beginning of Fiscal Year to Equipment Lookup in Cost
Accounting.

Version 8.58 (July)

No enhancements or changes were made in July.

Version 8.57 (June)
Added OT Hours column to Cost Accounting Browse. Changed drag & drop in Work Orders and Equipment Cost
by Task Code Analysis to right-mouse-click which is faster and enabled us to get rid of an OLE control which
makes startup faster.
Added Fiscal Year and Date audit to Cost and Fund Accounting and Fleet Management - Shop Work Order entry
screens. The audit runs in the background - - - if you enter a work date, purchase date or Fiscal Year that is in
variance with the system default Fiscal Year a message tells of this variance. The message can be overridden
and record saved. or a correction to Fiscal Year and/or work date or purchase date made before saving.
Default Fiscal Year is defined at:
From Quickest Menu -> enter E 3 times -> Department Info
From main ToolBar -> DATA -> Config & Setups -> Deptartment info button
Moved HELP button (which enters top of Help file) from main ToolBar to under the Help button (the one between
GASB34 and InfoAnywhere) on ToolBar to clean up ToolBar .
Version 8.56 (May)
Moved Visual Updates from Main ToolBar -> Utilities to Main ToolBar -> Help and and added our new EZines
option.
EZines is the start of, what we hope will become, a platform for projects, ideas, tips, tricks and ways you or the
people you work with, use road and bridge to save time and make for a more efficient use of your resources.
To share your ideas, articles, project pictures, tips and shortcuts just drop us an EMail (with or without pictures)
with what you would like to share. There are many money saving projects around the USA and we hope you will
use the newsletter to share them with others.
The other part of our monthly newsletter will be a review of individual modules. The module sequence will
roughly follow the module sequence in the box on page 2 of the ezine.
Please send us ideas and/or articles on what you would like to see in the EZines in the months ahead. Now that
our economy has slowed down there is more need, than normal, to share money saving projects, ideas and tips.
The very latest updates and patches from MicroSoft®, in conjunction with our continuous module improvement
program, will provide somewhere around a 15% improvement in overall speed on XP® and Vista® computers.
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Version 8.55 (April)
Changed all HELP to button selection (used to be PF1 key selection). This was done in order to make a Visual
for Help availability from Browses and Update Screens. Moved Help files (VisualRB.chm and Updates.chm) to a
separate folder (Help) under the main Road & Bridge folder. If you have problems accessing Help files use the
HHReg utility to enable access to these Help files. Call or EMail if you have questions. These changes were
made in response to security updates flowing from MicroSoft® and Security software vendors changes.
Added R/S Class to Recurring Work Orders - to update all Recurring Work Order records with current R/S Class
go to Software Tools - use with Care (Utilities window). From Quickest Menu, enter a D from keyboard and left
double-click mouse on Database Tools selection, or, from Main ToolBar -> Utilities -> Database Tools.
Version 8.54 (March)
Added Property Standards Module, alternate Actual Spending recap for Budget line item comparison and 5 new
state reports (GA, KS, NV) and 6 new reports under Report Manager -> Complaints and Property Management.
Increased width of GL# in Fund Accounting Query Reporting. Optimized 3 modules.
Set Fund Accounting Lite Non-Inventory Purchase to sortable.
Version 8.53 (January)
Added alternate Trucking module to make data entry much faster. The first time Trucking module is started an
automatic file schema change runs so module works in two different ways - depending on your needs.
Increased memo size in Projects Table. Added alternate method to Trucking Table and modified reports. Added
4 new state reports (MT, MN, KS).
Modified lookups for Traffic Rules and Traffic Ordinances. Added 7 new state reports (MO, KS, GA). Optimized
code in four processes. Optimized Quickest menu for faster hot key lookups (only first character of a module is
hot which is different from all other browse lookups in which all characters are hot). Optimized Google Maps®
automatic lookups.
Changed Google® interface from using Microsoft® OCX - now our lookup uses your default browser (MS®,
Firefox®, Chrome®, or others - - lookups are now much faster and don't create the scripting error which occurred
with the OCX control. GIS lookups include All Assets (roads/streets, bridges, culverts, signs, other assets),
Complaints and Permits.
To determine latitude and longitude of any asset or location you must first create [Sign in] (if you don't already
have one) a Google® EMail address (free), then click on My Maps on left side -> Browse Directory -> search for
'Latitude' and select getLatongPlus2 widget and add it to your toolset. Once its installed under My Maps, select it
(checkbox) and click on the map where you want to know the latitude and longitude (asset location). The latitude
and longitude display (highlighted) in box at botton left. Point at highlighted area, right click and select copy.
Return to Visual RB IMS® and click the paste Google latitude - longitude button to paste the coordinates into
record. From this point forward simply select any asset, permit or complaint and Google® It to see it on a map,
satellite, terrain and/or street view. Call if you have questions (80-0879--0517)
2008

Version 8.52 (December)
Added Traffic Rules and Traffic Ordinances module - these modules are related to the Signs module so you may
associate a specific Sign with its Traffic Rule and the Traffic Ordinance which authorizes the traffic Rule.
Set default Menu to the Quickest Menu (button-less interface to all modules). To use the Quickest Menu click
on it to gain focus, then enter any character from keyboard to scroll to the first occurrence of that module - enter
same key again for next occurrence, or enter another key for a different module. This menu is not "incremental"
as all other browse windows are - it is hot on the first character of the module name, only. Press spacebar to go
to top of modules selection table.
All standard menus are still implemented - click menus on ToolBar.
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Increased size of Equipment Memo - select Equipment so automatic update will update your data.
Version 8.51 (November)
Added interface to Permits so user, if desired, can relate Complaints to their respective Permit record. Enhanced
Permit Inspection table to handle unlimited number of Inspections.
Quickest Menu - try it, you'll like it
Changed the way Quickest Menu finds a module. The first key pressed ('step' search) goes immediately to the
first occurrence of that character in the module name - pressing same key again goes to next occurrence; i.e.,
only the first character of module name is search sensitive.
All other browse windows are 'incremental' searches.
Added Sign Ordinances and Traffic Rules modules - Help screens will follow.
Version 8.50 (October)
Added decimal to Scheduling Sequencing numbers to enable finer and easer "tuning" of Asset Maintenance,
Inspection, Equipment, Employee, Date and Tasking sequence. Added a locater filed to Quickest menu to
make it easier and faster to select any module without buttons.
Version 8.49.3 (September 5th)
Added Visual Style support so you may change colors, textures, wallpaper, buttons and default font types and
sizes - you may also add your own photos to wallpaper section for ultimate customization. (Screen re-scales
automatically on font size changes)
Access is from main ToolBar -> Utilities -> Configure Visual Styles -> Setup. You may also temporarily disable
all style changes during any session, if desired. Press PF1 HELP for explanations of data required when Visual
Enhancements input form is on screen - a default style is included. Add additional styles or modify existing ones.
As with all visual enhancements to any program, it takes more CPU clock cycles (and adds additional load to
the video card) to add visual "stuff". If you have an older (slower) computer, screen updates may be noticeable
(flicker, take a second longer, etc.). To disable all visual enhancements; (from main ToolBar -> Utilities ->
Configure Visual Styles -> Disable all styles).
To permanently delete visual enhancements; (from Main ToolBar -> Utilities -> Configure Visual Styles ->
Setup -> double-click the style in browse window - - Delete -> Apply -> Close. Exit Visual RB IMS and re-start
and visual enhancements will not be used; i.e., if you have a slower computer you won't lose CPU clock cycles
for visual "stuff".
Version 8.49.3 (September 1st)
Added On-Line support. You need a minimum of Windows® 2000 operating system (doesn't work with Win95
or Win98) and preferably a broadband (Satellite, DSL, ADSL, Cable, Fractional or Full T1). It will work on dialup
line, but is quite slow.
Go to ToolBar -> HELP -> On-Line Support. To connect, first, install CrossLoop®, or if already installed, leftdouble click CrossLoop® ICON on desktop, select Share TAB, Connect button, then call us with the 12 digit
security code - Answer YES to OK connection.
Your access code is unique on every session and no one can view session without your access code.
Version 8.49.2 (August)
Added Sequence switch to Scheduling to enable user control of report print sequences. Added Quickest Menu
selector which enables the easiest and fastest access to any module. Added By Area, By Task By Road/Street
report to Road/Street Reports. Added (back) forward/reverse sort to Cost Accounting Browse - Date Column.
Version 8.49.1.2 (July)
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Optimized Cost Accounting browse load time - Optimization was needed due to security updates to MicroSoft®
Server 2003, Vista® and XP® SP3.
Version 8.49.1.1 (July)
Optimized Cost Accounting Browse (prior to latest Microsoft update - note above) If your data in Browse is
not visible, point mouse at browse -> right-click -> List Formats -> Format Setup -> Delete All -> close -> close
browse and reopen. This will reset your browse selections to default. If you have problems call 800-879--0517.
Fixed premature closing of Complaints when Work Orders were generated directly from from the Complaints
module. Removed employees name from Schedule by Equipment Report.
Version 8.49.1 (July)
Added filter on Open Work Orders Browse to include partially closed work orders in Open Work Order Browse to completely close partially closed Work Orders remove the checkmark for the Inc (Incomplete) field.
Version 8.49 (July)
If you're experiencing problems accessing Google Maps® with Internet Explorer 7 it's due to a security
update by MicroSoft®. Check this URL for fixes: http://maps.google.com/support/bin/answer.py?
hl=en&answer=21849#
It provides instructions on how to "work around" the latest Microsoft security updates. The simplest method is
described under Make sure JavaScript, ActiveX, and 'binary behaviors' are enabled in the paragraph that begins
with "The easiest and safest way . . .". If you have problems please call us.
================================
The new HELP (VisualRB.chm & Updates.chm) may require you to run the hhReg.exe utility on a remote (not
computer where DATA files are located) computer IF the remote computer cannot access the new HELP system
files (VisualRB.chm & Updates.chm).
The utility (hhreg.exe) is located in the Visual RB IMS® root folder and must be run on the remote computer as
it updates that computer's registry to permit access to the .chm help files located on the server (if your system
is configured in this manner). MicroSoft® disabled the .HLP system in the Vista® release and also disabled the
ability to directly access their new .chm help . . . . . for security reasons? If you have any questions please call us
(8008790517) or contact your local computer support person.
- Fixed Edit-in-Place equipment browse
- Re-Set resizer on Complaints Browse
- Added filter and report to Projects analysis
-Fixed Equipment audit error on C/A entry
- Added Incomplete switch to Cost A/C entry
- Added 7 new State Reports (LA,GA,KS,TX)
- Corrected variables for spawning complaint to Work Order
- Added Complaint Report – by closed date
Version 8.48(3) (April, May, June)
- Set inventory attribute for Complete A/C entries
- Corrected Current/Previous year calc on GASB34
- Added record tagging to C/A and F/A browses
- Added FY Select to Scheduler
- Added button to W.O. screen for closing W.O.’s
- Added alternate GIS lookup switch in Complaints
- Added All Assets Maintenance Scheduling Module
- Added Scheduling module for Road/Street work
- Fixed previous meter loading in Cost A/C
- Optimized Cost Accounting Browse window
- Added GA EPD reporting to GA State library
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- Fixed Complaints spawning Work Order
- Added Foster Care module to Animal Control
Version 8.47 (January, February, March)
- Corrected TABbing on C/A entry screen
- Added Alt Road Name Switch for Google® lookups
- Corrected Right-Click issue on F/A Browse
- Added four new state specific reports
- Added Animal Control and Non-A/C tabs to Complaints
- Changed default browse colors on three windows
- Added State Road Intersects to Road/Streets Table
- Added Road Project Estimator to Road/Streets
- Modified logic to insure against accidental meter updates
- Added GreenBar to Browses for easier viewing
- F9 Copy key works on Browses (returned from Vista®)
- Add Browse Formatting (select columns and width)
2007
Version 8.46 (December)
- Added Spell Check to all screens - - - Press PF2
- Added Browse Formats (change columns and width)
- Added ‘Units of Work’ measurement field to C/A
- Fixed C/A Material Lookup table
- Added Info Anywhere browser (on main ToolBar)
- Added hyperlink to National Pipeline Mapping
- Added Google® maps to Complaints/Svc Request
- Added hyperlink to local or internet folders
- Optimized Road/Street Update screen
- Optimized Project Update screen
Version 8.45 (November)
- Added module to notify users of update installs
- Added Google maps to Road/Street Tables
- Modified 6 state reports (GA, TX, WY, ID)
- Added roads overhead cost allocation by labor hours worked
Version 8.44 (October)
- Added switch to NOT charge OT dollars on C/A record
- Added User warning module to ftp download
- Optimized screen draws in several modules
- Added separate buffer for purchase date
- Fixed PM Sequence # posting
- Optimized lookups for inventory Transfer module
- Fixed copy record and Cancel on C/A detail (Esc)
- Added resource selector to work order module
- Fixed work orders auto date
- Added memo field back on C/A browse
Version 8.43 (September)
- Added links to Fed R&B Standards (ToolBar -> Help)
- Report History & Notes module
- Added Complaints/Svc Request button to Quick Menu
- Added auto field for Road/Street - GIS sync
- Lookup in purchase module for scanned invoices
- Increased font size on Complaints reports
- Added quick find field lookup to Complaints browse
- Interfaced automatic Complaint Numbering
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- Wrote and modified 26 state reports (AR, GA, NE, NM, MT)
- Optimized Work Order data entry screen
- The F9 (Copy) key was ‘stolen’ by Vista – Use F7 now
- Added functionality to Complaints module
- Increased Revenues numeric length (added cents)
- Update final (of 3) steps to Vista® Aero compatibility
Version 8.42 (August)
- Fixed bug in By Employee/Project/Task Report
- Added three Complaints/Service Request reports
- Fixed bug in Completed Work Order Report
- Changed Svc Request print selector to single record select
- If overtime hours worked, OT rate defaults to 1.5 times
- Changed resize strategy on Complaints/Svc Request form
- Updated Form 10 in NE report library
- Updated Trucking Report library
- Modified state reports for AR and NM
- Added analysis codes to Complaints/Work Request screen
Version 8.41 (July)
- Added Time series graph to Equipment table
- Added 19 new state specific reports
- Enabled user Transfer deletes in C/A
- Added work order start date edit in C/A
- Added On-Line (web-based) training connection
Version 8.40 (June)
- Added 2 Employee work/Eqp Run time reports
- Added 12 state specific reports
- Added Time series graph to Road/Street table
Version 8.39 (May)
- Fixed work order number random ‘memory loss’
- Added employee lookup for purchase authorizations
Version 8.38 (April)
- Added Vendors w/ similar products lookup
- Added Oklahoma P.O. and Req. Forms
Version 8.37 (March)
- Edited Inv/Mtl “Measure” into 20+ reports
- Added 5 state specific reports
- Added ‘measure’ to Inventory Browse
- Added TWAIN scanning document management
- Added received field to Animal Control Adoptions
Version 8.36 (February)
- Added asset integrations to Google Earth©
- Summarized built-in GIS menu
- Added Equipment work by Task (Reporting -> Cost Analysis)
- Added Quick Menu (subset of often used modules)
Version 8.35 (January)
- Added GIS Lookup for locating Complaints/Srvc. Requests
- Added Road/Street Classifications button on Rd/St table
- Added Free Holiday to Comp Time tracking
- Tighter GIS integration with Bridges, Culverts, Signs
20

- GIS enabled Complaints/Service Request module
2006
Version 8.34 (December)
- Implemented Improved Browse window Re-Sizing strategy
- Added GeoCoded lookup to Complaints/Svc Request module
- Added What If Budget to Actual Spending analysis (Budgeting)
Version 8.33 (November)
- Added edit/delete to Vendor and Inventory history browses
- Moved Inventory unit of measure in Shop W.O. lookup
- Added Report Manager for easier report selection
- Added Equipment meter type to Cost A/C lookup
- Enhanced Send-To functions + Email from your system
- Removed Eqp Update button (on copy of C/A record)
- Optimized 224 modules/processes for faster execution
Version 8.32 (October)
- Optimized system load (< 5 seconds on 400MHZ computer)
- Moved updates to web-based ftp download
- Introduction of Visual R&B IMS blog next month
Version 8.31 (September)
- Added Cost Analysis by Surface Type reports
- Added Image Viewer to Complaints and Permits
- Added Image Viewer to Pavement Mgt
- Added two FEMA audit reports
- Optimized several Browse and Lookup screens
- Added Flood Plan Management module
- View images in any format (50+ formats)
Version 8.30 (August)
- Added Average Historical Cost Calculator to Inv Purch
- Added state reports and Animal Control Statistics report
Version 8.29 (July)
- Added Work & Weather analysis to WFP module
- Tweaked MO, WY, FEMA and several generic reports
- Optimized several process modules
- Added GIS analysis to Accident Reporting module
Version 8.28 (June)
- Widened total fields on Contract Trucking reports
- Removed auto date increment in W.O. module
- Solid Waste Management module released
Version 8.27 (May)
- Extended GL A/C# field on Purchase form
- Added Deposits table to Revenue Receipts module
- Added Solid Waste Management module
- Added Report totals to C/A Query report
- Added Road From/To to Work Order Memo
Version 8.26 (April)
- Added Shop W.O tracking to Inv, Eqp, C/A
- Added reports for LA, NE, AR, GA, MS, MO
- Added pictures to Animal Control module
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- Added additional functionality to Receipts
- Added alternate Road lookup to work orders
- Fixed Eqp PM code in Shop W.O module
- Added additional lookup data in C/A module
- Added GASB34 cost layer depreciation control
- Opened Permit Control # for syncing with local #
- Added GASB34 Asset Base Cost Estimator
Version 8.25 (March)
- Added Township lookups to BR, CU and Signs
- Added auto close to Equipment select in F/A
- Added Accident Reporting module
- Added Code link - Shop work to misc. project reports
- Added Date Paid to Fund A/C browses
- Added close to Eqp select in Fund Accounting
- Moved Receipts/Date in Revenue Receipts table
- Added new functionality to Animal Control module
- Corrected format on Bridge Sufficiency Graph
Version 8.24 (February)
- Removed single record print button on Browses
- Added View button on Road/Street Record
- Moved Alt Rd/St column in Road/Street browse
- Auto clear GL# on Close of Material lookup
- Corrected Rd/St Lookup in Permits
- Enabled sort header on Labor – Fleet Mgt
- Added 4 decimal accuracy to Road/Street length
- Modified Browse in Contract Trucking module
- Modified R&b IMS© Configurator to 2006 levels
- Cleared GL A/C # in C/A Materials
- Added Shop Lead to Eqp Repair Record
- Added KY State library
- Modified OH, KY, LA, NE, AR, MO, TX reports
- Moved (retained) meter reading to center of C/A screen
Version 8.23 (January)
- Added Location table (with descriptions) to Inventory file
- Set incremental find on Work Order labor lookup
- Fixed Tasks button on Functional menu
- Added feet and square feet to Road/Street table
- Added Segment ID to C/A and Road/Streets tables
- Fixed Estimator line item form (again)
- Added reports to TX, LA, OH and Benefits libraries
- Added Animal Control Notification module (GA)
- Added Copy button to Road/Street Browse
- Fixed auto salary to hourly calc (Labor)
- Set cursor to hours when converting salary to labor rate
2005
Version 8.22 (December)
- Added salaried annual work hours calculate – Labor Table
- Fixed Project Detail Costs ToolBar Browse Control
- Added cost per Hour/Mile auto-calc on Eqp Maint History
- Added MT State library and reports to MS, MO, LA, FEMA, libraries
- Added Memo field search to Query Wizard on Inventory browse
- Auto clear pay rate field when comp hours (other) field = A
- Added Floating Functional Menu
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- Added Trucking Report for fixed per mile rate analysis
- Added Open Work Order lookup to Shop Work Order Browse
Version 8.21 (November)
- Added/modified ID-IN-MO-MS-NE-OH-TX-WY and Benefits reports
- Added date range select to Unpaid button (F/A Lite)
- Opened Benefits Earned field in Benefits Module
- Added viewer to Employee Record to display pictures
- Added R/S Switch for alternate (IN) Work Order system
- Modified Trucking module
- Added Asset Listing module to Cost Accounting Memo
Version 8.20 (October)
- Modified Benefits module to handle dual work codes
- Added several state reports
- Added Copy button in Contract Trucking module
- Raised button on Eqp Rates on C/A entry screen
- Fixed Employee/GL# lookup in C/A
- Added “Hide” switch for Hrs Worked in Week module
- Preserved memo data when changing Fund A/C record
- Expanded memo field on Fund A/C records
- Added Rock Sales to customer report
Version 8.19 (September)
- Added ‘Closed’ option to RoadStreet Classification
- Added autofill for Project select in non-inv purch
- Added two Comp Time Accounting Reports
- Added Idaho Equipment Report
- Added editing flexibility to Eqp Cost browse
- Added editing flexibility to C/A browse
- Added expandable memo to Cost A/C (WIN) record
- Added Pay All button on Unpaid Purchases browse
- Widened Inv# on by ComCodes by Location report
Version 8.18 (August)
- Added Quarry transaction subsets to Material lookups
- Optimized Shop W.O. Detail entry form
- Fixed Shop W.O. Utility Calcs
- Added (Idaho) FEMA reports
- Added Print button on Road Work Orders screen
- Modified Project Detail Cost Report
- Added KS State Annual Report
- Added Ohio Budget – Spending – Encumbrance report
- Added Vendor Name on Shop Work Orders (Material)
- Added 3 decimal accuracy to Road Segment Length
Version 8.17 (July)
- Added Graphic (Sufficiency Rating) to Bridge Table
- Added license number field to Equipment Browse
- Set labor rate to 4 decimal accuracy (Auto Update)
Version 8.16 (June)
- Added filter for Sold Equipment in lookups
- Added SEND button on Road/Street Cost History
- Added Project Select to Shop Work Order Module
- Modified OH State reports
- Added full name post from Shop Work Order module
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- Modified and added report to OH Sub GL budget module
- Information Pyramid (Info flow graphic) [Utilities menu]
- Re-Wrote WEB page generator for speed and ease-of-use
Version 8.15 (May)
- Added Misc/Location Field to R & S Cost History Report
- Replaced Date Paid on Inventory Purchases screen
- Added Meter/Date Post switch to Shop Work Order screen
- Added Equipment Meter Audit reports (Eqp Browse)
- Added Personal Time on Benefits Module
- Added Brush control form letters to Complaints library
- Corrected spelling of “Authority” on GA report
Version 8.14 (April)
- Added # of Report Copies selector
- Added Road/Street (Location) to Permits browse
- Added subtotal to Rock Tickets Report
- Added State (GIS) code to Material Purchase
- Added TX report (Hopkins County)
- Added switches for inventory posting
Version 8.13 (March)
- Added reports to OH State library (Jackson County)
- Added report to KS State library (Ellis County)
- Added reports to NE State library (Hall County)
- Added 2-digit decimals to Sub-GL Module
- Added Current & Previous Year Spending to GASB34
- Added Daily Benefit Hours Audit Report
- Modified Authorized By field in Purchase module
- Optimized Hours Worked – All Summary Report
- Added Eqp PM Scheduler (Equipment Browse -> PM button)
Version 8.12 (February)
- Added auto Equipment check on F/A Lite Non-Inventory Purchase
- Added vertical scroll functions to several browse windows
- Fixed FY filter in Sub-GL module
- Fixed Tabbing sequence on Cost Accounting (WIN) entry screen
Version 8.11 (January)
- Added new Wyoming Inventory Report
- Added ShortCut for paying open invoices (UnPaid Button)
- Added field to capture Sales Tax on F/A Lite (for analysis, etc.)
- Restored shop WO detail record date when using utility
- Added Tax Report in Arkansas State Specific Reports
- Added Invoice Report in Nevada State Specific Reports
- Added Task Summary report in Project Reporting
- Hide payroll rate and extended dollars IF User Security level < 7
- C/A entry now provides labor hours at Labor Button click
- Added Task Cost Summary Report (Reporting -> Cost Analysis
2004
Version 8.10 (December)
- Added Sub GL integrated with main GL Budget
- Added Individual Fund to Spending Analysis
- Added SubTotal Hrs Worked in current week in C/A
- Added additional posting detail in C/A DOS style entry
- Fixed FileDropDowns on RoadStreet entry
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- Added a couple OH and NV State Reports
- Optimized Fuel Efficiency Calculator
- Changed automatic OT Rate selection to manual select
Version 8.09 (November)
- Replaced filter on Employee Lookup Tables
- Added fields to Physical Inventory Report
- Added memo field to C/A one-shot report
- Added Date Selects to C/A and F/A browes
- Enhanced GASB module and added SEND button
- Fixed WEB Page generator
- Left justified Task Code on C/A input form
- New Report (WY)
Version 8.08 (September- October)
- Faster Engine – 15%+ faster Reports/Searches
- New Reports (KS,GA,NE)
- New FEMA Rates Table
- Changed C/A OT Rate default selection
- Added subtotals for other assets report
- Set Default Shop WO Work Date to WO Start
- Shop W.O. GL # Posting corrected
- Corrected Shop W.O. GL Posting
- Enhanced Sync Shop W.O Totals Utility
- Added Close Button to Projects Browse
- Added Nevada State Report library
- Modified Budget to Actual Report
- Added acquistion value to Other Assets Browse
- Added new Sign Form Report
Version 8.07 (August)
- SEND to printer or file (.pdf, .html, .xls, .doc, .csv)
- Added Blanket Purchase Orders to Vendor file
- Moved Signs/Bridges doc view buttons to Browses
- Corrected C/A Audit Report
- Added Subset Filter to WIN Cost Accounting Browse
- Added ‘As of Date to NE Form 3 Reports
- Moved Fuel Efficiency button to Browse window
- Added select FY Spending TAB to Vendors Browse
- Added GA County specific reports (Permitting)
- Added Auto Multiplier button on F/A and Inventory
- Added Preventive Maintenance Types and Reports
Version 8.06 (July)
- New Township Summary Paged Report in Asset Mgt.
- Corrected Commodity Code embed with ENTER key
- Corrected decimal error on (single record) labor report
- Added record edits to Maintenance History TABS
- Added Budget GL# Balance and Encumbrance
- Added Hall Cnty Purchase Voucher (State Specific -> Alt)
- Added ‘SOLD’ filter to Equipment List Reports
- Added Paged Other Assets report
- Changed automatic Work Order date closing routine
- Changed Deck field in Bridge module to first screen
- Added new GA Budget to Actual Report
- Added new CO Monthly Department Activity Report
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Version 8.05 (June)
- Pavement Management Module Released
- Fixed Shop WO Date posting to C/A
- Changed Commodity Code selector to work with TAB key
- Modified OT hours to use 0 or 1 as a multiplier rate
- Added Inventory Location sort to Off-Road Fuel Report
Version 8.04 (May)
- Added print filter to Cost Accounting Query Wizard
- Added Work Order Origination date to reports
- Added Sign Query Wizard Report
- Added date filter on Project Invoicing module
- Added GL#’’s (222.00, 301.09. 302.07) to NE State Eqp Report
- Added Work Order Inventory Number Upper-cased to Shop WO
- Added graph to Pavement Mgt module: Visual of all Roads/Streets
Version 8.03 (April)
- Fixed F7 (Field copy) on several input screens
- Added automatic subtotals on non-inventory purchases queries
- Use Cost Accounting lookup for Closed Lite Work Orders
- Fixed Cursor positioning when using hotkeys
- Added Tip-of-the-Month (monthly tip)
- Added two sign reports
- Added Work Order Lite Report
- Added graph to Pavement Mgt module: Visual of all Segments
- Pavement (& non-pavement) Management Module (May, ’04)
- Added Escrow Account module for Escrows/Bonds management
- Changed to reverse system sort order for Permits Browse
- Overtime Hours worked Auto default to 1.5 rate on WIN C/A entry
Version 8.02 (March)
- Fixed inactive TAB KEY on Fund Accounting
- Made several changes to NE Library Reports
- Added Meter Reading and Vendor # to Shop Work Orders
- Fixed Cost Accounting Query Wizard print
- Manually update completed Projects – Update Button all others
- Optimized Update All Project processing speed
- Added new Personnel and Sign reports
- Auto-Date added to entry forms (previous date is next date)
- Modified Shop W.O. detail entry screen for larger dollars
- Lengthened Bubble HELP viewing time to 10 seconds
- Started development on Pavement Management Module
- Pavement (& non-pavement) Management Module (May, ’04)
Version 8.01 (February) (New Version Release)
- Faster Data, Search and Print Engines in the new V8
- Sort\Search on any column in any Table (100% flexible)
- Added graphs to 2 data windows – additional graphs later
- Re-formatted MPG/GPH Report
- Added Quarry Ticked # field on Fund A/C Inv Purchases
- Added Equipment Meter reading on Equipment Cost Report
- Added Task Column and TAB to Shop Work Order Browse
- Added Material Sub Totals on Equipment_History Report
Version 7.21 (January)
- Added GIS Editing Tools (Utilities -> Configure GIS Labels)
- Added Copy button to Complaints Browse Window
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- Inv Adjustment no longer attributed to vendor
- Added Road TAB to Bridge, Signs, Culverts, O Assets (C/A)
2003
Version 7.20 (December)
- Added Other Assets Table (under Cost Centers)
- Added automatic highlighter to Purchase Memo fields
- Added Quarry Tickets TAB to Cost Accounting Browses
- Added automatic loading for “long-term” purchase order
- Re-Install of Adobe© Reader V5
- Added Purchase Order # override - any number is allowed
- Optimized loading of Vendors file
Version 7.19 (November)
- Re-Wrote Inventory Transfer module
- Set reverse date sort on Inventory Adj. Browse
- Added Copy button to Weed Control Browse
- Fixed Inventory Audit Utility
- Optimized Cost Accounting Browse Windows
- Added W to comp time (Workmens Comp time off)
Version 7.18 (October)
- Budget Amendment module (Select line item to amend it)
- Added two new Sign Reports
- Added Sign Lookup for Cost Accounting (WIN) entries
- Added Culvert Lookup for Cost Accounting (WIN) entries
- Added Bridge Lookup for Cost Accounting (WIN) entries
- Added complete MUTCD manual (reference signs table)
- Added NE Form 3 by Standard Cost Report
- Optimized NE Alternate Actual to Budget Report
- Added Complaint Date (reverse sort) on Complaints
- Added Reference - Side Road on Signs “B” screen
Version 7.17 (September)
- Added memo field to Complaints (one button click print) form
- Added Remarks field to Equipment Profile Report
- Added Auto Calc to Non-Inventory Purchases (you may override it)
- Enhanced Bridge file – Run BrigCnv.exe conversion utility
- Fixed Bind on RoadStreet TAB in DOS style entry screen
- Removed automatic-next-entry screen in Cost Accounting
- Re-sized right columns in Query Wizard Reports for report compatibility
Version 7.16 (August)
- Streamlined Cost Accounting Entry to save keystrokes
- Added FY Select to Equipment History screen (Eqp Module)
Version 7.15 (July)
- New Project Report: By Employee, by Project, by Task
- Fixed Inventory Adjustment updating problem
- Above also fixed (ALT-O) Shortcut key in Cost Accounting module
- Fixed Purchase date reset in Purchase Orders Complete
Version 7.14 (May)
- Added Copy and Paste (PF7) buttons for C/A memo fields
- Updated Adobe© Reader from Version 3 to Version 5
- Several modifications to NE State Reports
- Updated Inventory audit utility
- Updated KS-AR2 reporting utility
- 2003 Module Pricing (Utilities -> R&B_IMS Configurator)
Version 7.13 (April)
- Added Permitting Module
- Fixed filter on Cost Accounting Project lookups
- Added Transaction Field to several Fund Accounting reports
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- Added General Ledger # range search on several Budget reports
- Added Estimated Cost by Preventive Maintenance Code types
- Added lockout on Purchasing Lite button during posting process
Version 7.12 (March)
- Corrected Open Projects TAB select – Run Audit to update
- Added Alpha basis to Commodity Codes; use numeric or alpha
- Added Equipment Parts Warranty File (for warranties tracking)
- Activated Purch Lite Payment date reset switch issue
- Added Pay Rates file for multiple pay rated employees
- Added Texas (Denton Cnty) Budget Report
- Added Posting shortcut from Purchase Orders to Purchase Lite
- Enhanced Weed Control Module, new report, additional GIS hooks
- Projects – C/A Utility (Utilities -> DataBase Tools -> Reclassify)
Version 7.11 (February)
- Module name change: Executive Info System (EIS) to DashBoard
- Eqp Trans Report to 16-bit Print Engine for Intel© XP© compatibility
- Added KS-AR1 Report (Summary totals from supporting reports)
- Added modified Projects by Work Done report to KS State reports
- Added Project Cost Reports: By Township – Project – Task
- Added GA Payroll Report under State Specific Reporting
- Added Material Reports in NE State Specific -> Alternate Reports
- Added Material description to Shop Work Order Detail Report
- Added Texas Budget Report under State Specific Reporting
- Added Phase, Township and Rock ticket to Fund A/C Lite screen
- Added Copy Button to Purchase Orders (Accounting Complete)
- Added date filter to Projects Completed Report
- Added By Township, by Project, by Task Reports (Sum/Detail)
- Added FEMA Rates Report (Reporting -> Config & Setups)
Version 7.10 (January)
- Added Transaction Info field to Query Wizard in Purch Module
- Added interface to add inventory items in C/A, Purch, Shop W.O
- Added Partial Unit(s) Converter for Material Units Applied
- Added two new by Township, by Road/Street Cost Reports
2002
Version 7.05 (December)
- TearOff Menu; i.e., a user created custom menu shortcuts
- Added Material type Filter on Eqp Maintenance Costs
- Added new suite of Eqp PM Reports sorted by Eqp #
- Added TAB and report for Sold Eqp still kept on books
- Added new Eqp Report for Maintenance Repairs & Labor
- Modified PATHing for compatibility with MS XP© - SP1
Version 7.04 (November)
- Added FEMA Rates Selector to Equipment update form
- Modified Main Menu for better visuals in 640x480 resolution
- Added Copy Buttons to Inventory and Budget Browses
- Apply your own wallpaper with Wallpaper Selector under Utilities
- Corrected filter on Fund Accounting Purchases
- Added parser to all Report Entry screens to parse for valid dates
- Changed Shop Work Order functionality for easier and faster use
Version 7.03 (October)
- Corrected Fleet ops – Summary Report
- Added code for Viewer engine on all Windows© platforms
- Added Inventory Quantity Audit checkpoint when using materials
- Added Task Button entry on Equipment Shop Work Order Details
- Added Date on Shop Work Order form
- Added Query-by-Example (AltQuery Button)Cost/Fund Accounting
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(Query-by-Example and Query Wizard provide more functionality)
Version 7.02 (September)
- Added additional functionality to Complaints File
- Shop Work Order Report -> Equipment Maintenance History TAB
- Very Fast Query Wizard replaces Standard Query Tool
- Cost Analysis Reporting section under Reporting menu
Version 7.01 (August)
- Licensed new Graphics Imaging Engine Utilities -> I View32©
- Corrected January fuel usage calc in Fuel Usage Calculator
Version 7.00 (July)
- Faster Software Engine and other under-the hood enhancements
- Added lookup window to make Data BackUps easier/faster
- Optimized Complete Work Order Module - 100% mouse entry
- Aded Fuel Usage Report; Reporting -> Cost Centers -> Materials
- Selectable GIS configurations if moving GIS to different Drive/SubDir
Version 6.72 (June)
- Moved default home from \Program Files\R&B_WIN to \RB_IMS
(due to MS© Server lockdowns in WIN2K, XP and future MS© Op Systems)
- Added sign-off on Purchase Order Lite forms
- Optimized Project Analysis Browse Window (EIS menu)
- Added limit filter for Equipment new entry screen P.M. button
- Optimized Main Project Browse Window
- Added three record checking routines to Eqp Shop work Orders
- Increased width of Equipment In Service Date field
- Modified filter on Fund Uses to sync with Cost Accounting
- Added input screen for NE Purchase Orders
- Added General Ledger# sort on NE Claims Report
Version 6.71 (May)
- Added Sign Types database for lookups (MUTCD standard)
- Optimized load time when running Norton© & McAfee© Antivirus
- Added Format Utility (Floppy Drive A: only) to Backup Module
- Added By Location Index tab (or column header) to inventory Browse
- Added Equipment Shop Hours Worked Reports
- Corrected W.O. Modules (Lite & Complete) for random data loss
- Shop Work Order detail records in Cost Accounting after post
Version 6.70 (April)
- Added Recurring Work Order Module (WO of extended times)
- Optimized Labor Hours current FY lookup (Personnel File)
- Added several enhancements to GASB34 module
- Added Emission control to Shop Work Order Safety check
- Added Copy button to Puchase Orders Complete
- Added field to Shop Work Order Browse window lookup
Version 6.64 (March)
- Added By Equipment # TAB on Cost Accounting Browses
- Changed Material Cost/Unit (Cost A/C) to 4 decimals
- Corrected record delete in Shop Work Order module
- Added Vendor/Contractor/Customers (ALL) Report
- Modified Signs (single record report) to print full Lat/Lng
- Corrected memo field overwrite in Inventory Adjustments
- Lengthened Location field in Sign Browse window
- Added Authorized Tab to Accounting Complete Purchases
- Added Asset Control Number to Equipment File (PM Info TAB)
- Removed default Project Length of one year (Project Length)
Version 6.63 (February)
- Enhanced File Recovery utilities (Utilities -> DataBase Tools)
- Enabled delete capabilities to Shop Work Order line items
- New Commissioners Road Cost Report (Road Mgt Reports)
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Version 6.62 (January)
- Added new NE Form 8 report (Project priority sort)
- Integrated WIN XP’s MS Graphics Engine to R&B IMS© App
- 2 Material Used Reports (Reporting -> Cost Centers -> Materials)
2001
Version 6.61 (December)
- Added TAB to Complains Browse for Name order view
- Added Last Name sort TAB to Closed Complaints
- Cosmetic changes to Main Menu
- Modified A/P Complete Accounting filter to work two ways
- Changed TABbing sequence on Cost Accounting Details
- Re-worked Fund Accounting Uses Eqp. meter/date update
- Added/Optimized WEBPage generator (summarizes Maint costs)
- Re-worked logic and optimized MPG/GPH calculator
- Inventory Transfer In Cost set to equal Transfer Out Cost
(Transfer In Cost was set @ Std. Cost of item Transferred To)
Version 6.60 (November)
- Added multi-Equipment Rates (for different equipment configs)
- Cosmetic changes to Main Menu
- Restored Enter Key for Project Selection (Cost Accounting)
Version 6.59a (October)
- Filter for Cost Accounting on W.O. generated entry
- Optimized several reports for faster generation
- Moved Lite Payables Voucher Button to Fund A/C Uses
- Added Paid/Unpaid TABs to Fund Accounting Uses
- Report by Road(s), Task(s), Date(s) (ALT R M Y)
- Fixed OT Hrs Subtotal - Detail Cost Report
- Added Equip Transaction Report (Cost Centers/Eqp)
- Added Memo field to Equipment Maintenance History
- Added Resizer to Projects Browse Window
- Optimized TABbing in Cost Accounting entry screen
- Optionally create W.O. directly from Complaint
- Added AutoNumber to Work Orders Lite
- Added MN State Reports
- Added Fixed Asset Category button to Equipment
- Added Select Button to Work Orders Complete
Version 6.58 (September)
- Added 2 Project Subtotal Reports: by Work Done
- Select printer (FAX, etc.) to Work Orders
- Optimized Employee Hours Worked Lookup
- Added Open/Closed Complaints Reports
- Added a Fiscal Year Re-Classify Utility
- Combined (to Menu button) both menus
- Added Report: Material, Dates, Project Name
- Optimized Inventory Audit Utility
- Optimized Road/Street Profile Lookup
Version 6.57 (August)
- Added Work Orders Complete Module
- Updated Purch Date on Direct Purch for date changes
- Added new paper size to A/P Complete voucher
- Road/Street Profile: Asset lookup by Road location
Version 6.56 (July)
- Modified Management Reports: Summary/Detail by Road(s)
- Fixed Material Purchase Lookup
- Added Equipment Fuel Usage Graphics (one-click analysis)
Version 6.55 (June)
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- GASB34 Utility: Other Programs data import/export
- KS AR4 Report Worksheet (KS AR2)
- Modification to KS Purchase Orders
- Optimized several data entry Forms
Version 6.54 (May)
- Added Alternate NE specific reports ( ALT- R S N A )
- New Contracts Management Module (DOS Menu)
Version 6.53 (April)
- Integrated Work Order Module (DOS menu: Management)
- Added Overhead Allocation by Equipment Hours Utility
- Fixed inventory transfer dupe
- Budget Report subtotals Mod(Budgets or Report Header)
- Fixed index lookup on Fund Accounting
- New (month select) Budget Report (Reptng->Accntg->Budget)
- Modified Copy button to copy record data vs. current date
Version 6.52(March)
- Added new QuickSearch function: Find, Tag and Reporting
Version 6.51 (February)
- Optimized DOS style entry screen routines
- Fixed index lookup on Fund Accounting auto Vendor embed
- Added current FY Maintenance History Tab to Equipment
- NE Form 11 Filter change to look at Project Completion date
- Separate utility to upgrade Complete Accounting
- GASB34 (version 1.0) Please send us your particular needs
- New Report by Township, date range, Inventory and GL#
Version 6.50 (January)
- Added new Form 7 (non rounding) reports to NE Library
- Added Purchase Vouchers; Complete Accounting -> A/P button
- Added three Employee Benefit Hours Reports: (ALT R C P B)
- Corrected totalling error on Financial Accounting by GL # Report
- Added Salary field in Personnel database
- Added Payroll Vouchers (Bi-Weekly & Monthly; ALT R C P I or M)
- Added Reporting ->Acntg Reports ->Complete Acntg (client invoices)
- Version 2 of 3-D TopoQuads available; select Ver 1 or 2 at runtime
- Added Security Module for User and Module level security control
- Optimized slow response on Work Date TAB in Cost Accounting
- Added Inventory TAB to Cost Accounting (WIN) Browse window
2000
Version 6.42 (December)
- Added Employee Benefit Hours Earned/Used module to Personnel
- Set reverse date sort on Hours Worked by Selected Employee report:
- Optimized Eqp Cost Summary Report (Cost Centers -> Equipment)
- Optimized Bridge Maintenance Cost history lookup
- New Report->Accounting->Fund Accounting->Record Level Audit
- Set reverse work date order in Cost Accounting & SRM screens
- Optimized Invoicing Project Cost Summary routine
- Optimized Culvert Maintenance Cost history lookup
- Corrected redundant Cost Accounting entry screen save query
- Optimized Sign Maintenance Cost history lookup
Version 6.41 (November)
- Added monthly depreciation calc to Depreciation module
- Program logic change for Nebraska Counties
- Changed inventory update logic on Cost Accounting Screens
- Reworked Preventive Maintenance Select on Equipment Screen
- Made EIS menu smaller and changed ALT-?? key combinations
- Fixed Ver 6.4a for clearing Eqp PM Meter/Date settings
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- Reworked Preventive Maintenance Select on Equipment Screen
- Added Total Historical Cumulative Cost Tab to Sign Screen
- Corrected Fund Accounting Report Totalling error
- Added Warrant/Invoice # on Purch Screens and modified reports
- Added GL A/C# Lookups on Complete Accounting P.O. Detail
- Added Unit of Measure (for reference) on Purchase Screens
- Added/Interfaced Bridge Detail Costs Lookup (Bridges Database)
- Added Shop Work Order PM Date/Meter ReSet switches
- Added PM Shortcut ReSets to Cost Accounting Screens
- Added/Interfaced Signs Detail Costs Lookup (Signs Database)
- Added Fund Accounting by GL A/C # by date range Report
Version 6.40 (October)
- Set reverse date order on several reports that use detail records
- Backup/Restore Compressed Archive module (under File menu)
- Changed several pop-up selectors so Cancel Button clears field(s)
- Automated two postings in Shop Work Order for data entry speed
- Changed Equipment so P.M. is selectable vs. auto popup file
- Budget Rollover (Next to Current-Current to Previous) (YearEnd Utils)
- Reclassifiy Projects; Roll open projects to current FY (YearEnd Utils)
- Enhanced Report Engine in 6.313 Upgrade
- Run Automatic Rec Conversion
- Corrected Cost Accounting second entry when using Copy Button
- Changed Fund Accounting Direct Charges for instant cost update
- Added Copy buttons to Inventory/Non-Inventory Purchases
Version 6.313 (September)
- Added Copy buttons to Inventory/Non-Inventory Purchases
- Added intelligence to data to increase reports speed (Run IconsRUN_ICONS)
- Added Accounting Report -> Budget Reports -> Budget and GL
- Corrected code error in Budget to Actual Report
- Rewrote Budget to Actual Alternate to make it faster
- Added NE Alternate Budget Report (increased speed)
- Added Vendor by Fund Charged Report (Date Range Select)
- Corrected random field data change problem with Copy Button use
- Changed Cost Accounting (WIN) TAB order Eqp Exp (Date/Meter)
- Added Reference field to Fund Accounting and Equipment Reports
Version 6.312 (August)
- Added home phone to Personnel browse screen
- Added Equipment meter reading update button to Fund Uses
- Added Remit to on Invoices (pulls from Entity address)
- Corrected and optimized Hours Worked Report
- Added Paged & Selected Employee Hours worked Reports
- Added Reminder/Scheduler button to Splash Screen
- Added Print button to Estimator File (single record print)
Version 6.311 (July)
- Added Scheduler/Reminder Module (Control - S; Utilities Menu)
- Introducing R&B IMS Visual 2000VISUAL2000
- Added Quarry Ticket to Query module in Cost Accounting
- Optimized reports: Weed Control, Payroll, Vendor, Personnel
- Added Charting capability to Project Analysis module
- Changed Fund Accntg. display A/C# to display alpha and numeric
- Optimized Project Overhead Allocation Module
- Added Print button to Complaints Module (for individual record)
- Added RightMouse Button select for Vacation/Sick Leave, etc
- Added unlimited length memos to Bridge File
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- Optimized Project Detail Cost Analysis "Analyze" routine
Version 6.30 (May)
- Added Bar/Line/Scatter/Area graph Charting to E.I.S (Summary FY)
- Added All Materials to Browse Data -> Cost Centers -> MaterialsMATERIALS
- Added Bar/Line/Scatter/Area/Pie Charting to E.I.S (Budget)
- Added new Personnel DataBase (Run PERSONEL.EXEPERSONEL.EXE)
- Introduction of IntraNet SiteINTRANET_SITE for R&B IMS users
- Added termination date Field to Personnel File
- Optimized opening Cost Accounting Windows Entry screen
- Changed Encrypted Control File to Non-Encrypted ReadmeREADME
- Changed Executive Information System ~ E.I.S. (Hotkey:CtlI)
- Added DOS Style Main Menu (Hotkey: CtlM) for easier access
Version 6.203 (April)
- Added demo Digital 3-D Topos (for your city/county)
- Added Overhead Applicator for applying overhead to Projects
- Added Standard Cost/Average options for inventory valuation
- Added E.I.S. (Executive Info Sys for instant info access
- Moved Shop Work Order G/L select buttons (down)
- Added Project counters (Total, Current FY and Active)
- Added transfer dollars to inventory transfer report
- ShowTime (slide show for R&B IMS info/training)
- Added Query button on Utility location file (GIS)
- Added variance over/under Audit Report for eqp hr/mi costs
- Added Labor Hours cost field to Funds Uses screen
- Added Equipment # to Equipment Continuation report (NE)
Version 6.202 (February)
- Added Close buttons on Cost Accouting Pop-Up windows
- Added Vendor and Memo to Cost Accounting Entry Audit Report
- Enabled OK button to activate with <ENTER> key (Cost A/C)
Version 6.201 (January)
- Extended Mi/Hr field in Shop Work Order Module
- Added Project Report for printing a range of projects
- Corrected Shop Work Order material usage posting
- Rewrote invoicing to multiple lines vs. summary lines
- Added Task and GL A/C buttons to Shop Work Orders
- Reorganized (Win) Cost accounting screen for entry efficiency
- Removed OK button from (A/P) Purchase Order History form
- Added Work Task Button to Shop Work Order Module
- Added posting to Complete Accounting purchase order module
- Disabled (Win) Cost Accounting auto dates (use F7 for to dates)
- Added Transfer Module (Under Cost Centers -> Materials -> Tran)
- Modified KS AR-3 Report for Layer Codes with leading zeros
- Added Payroll report for single periods (Weekly/Monthly)
- Modified Paid/Unpaid Filters on Accounting Lite - Fund Uses
- Changed filters on Equiipment History reports
1999
Version 6.200 (December)
- Added Alternate Budget to Actual Report (faster)
- Enhanced Weed Control module for KS State reporting
- New Weed Reports: A/R, Chemical Sales, KS State report
(more reports will be written as you suggest them)
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-

Run XWeeds.EXE to convert old data to new formats
fix on Invoice module Cost Accounting summary
Added default GL A/C Lookup button to material purchase screen
Added Labor/Matl/Eqp fields to Cost Accounting Screens
Added Audit report to compare Standard to Actual Costs
fix on Labor and Material GL A/C code LookUps and Vendors

Version 6.124 (November)
- Added Order by Date Tabs to both Cost Accounting Browse windows
- Corrected Material lookup/embed A/C# in DOS style entry screen
- Increased field lengths in Vendor, Address and added Address2
(To move old records to new database run (XConvVen.EXE))
- Changed index basis for Complaint/Warning file
- Added dupe key (PF9) and button to speed up data entry
- Changed index basis for Task Code file
- Added Print Screen function using MicroSoft Paint program
- Added Benefit hours field to DOS entry screen
Version 6.123 (October)
- Added mass mailing for Complaint/Warning letters module
(To move old records to new database (Xconvert.exe))
- Added Cost Accounting report for range of road segments/dates
- Road segments report available under Asset Management Reports
- Optimized year end indirect expense and depreciation routines
- Cleaned up redundant characters on Browse & Update screens
- Added memo field to PM file for procedures/parts
(To move old records to new database (Xconvtpm.exe))
- Hazardous Conditions Report under Simplified Road Management
Version 6.122 (September)
- Rewrite Equipment History and Summary reports
- Rewrite invoicing module works auto/non-auto line item mode
- Finalized Form 1f - Nebraska reporting (Contracts > $10K)
- Added checkbox for flagging Projects as LOCAL REPORTs
- Rewrite of A/R, Aging Report; Complete Accounting
- Optimized report generator on several report options
- Added Project TimeLines Report on Project Vue window
- Rewrite of Accounts Payable Report; Complete Accounting
- Revision of Vendor Purchase history report
- Addition of Vehicle Number to Query on Purchases screen
Version 6.121(a) (August)
- Optimized (DOS Style) Cost Accounting Entry Screen
- Additions to HELP and How Do I ... HELP modules
- Redesign Fund Uses screen for direct charges to equipment/projects
- fix on Revenue Sources filter (induced by b ver upgrade;Ver 6.12)
- fix to replace hotkey functions on several popup windows ( " " )
- fix on Material Purchases module
("")
Version 6.12 (July)
- Mods to Inventory Adjustment Module for Inventory moves
- fix on Cost Accounting (Labor, Matl., Eqp.) [ALT] Lookups
- Modifications to NE Report #7
- Depreciation (w/without salvage values) utility
- Indirect cost allocation utility
- Interface to MS Explorer for "on-disk" backups
- Daily Cost Accounting Input Report
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Year End utilities for Equipment Depreciation Calculation
Update to Clarion 5b Enterprise Edition Binaries
Several Query speed enhancements (B Version upgrade)
Project Costs by Work Performed Report
Menu select Interface to My Report LibraryMY_REPORT_LIBRARY
DataBase tools for updates, file recovery, etc.
Project Costs by Material Used Report
fix in Inventory Adjustment module
Bi-Weekly Payroll Report
Additions to How do I!ExecProgram("WINHELP.EXE HowTo.HLP",0) ... HELP files

Version 6.11 (June)
- Financial Accounting module and Statements module
- Bridge Inventory Coding Guide (Acrobat .PDF)
- How Do I!ExecProgram("WINHELP.EXE HowTo.HLP",0) .... module-by-module tutorial
- MUTD Part 2-D Sign Guide for conventional roads (Acrobat .PDF)
- New Payroll report for Weekly, Bi-Weekly or Monthly periods
- Tip-of-the-Day and What happened on this date module
- Addition of Trans_InTRANS_IN.TXR (Transfer new report from CompuLink to you)
- Enhancements to Weed Control Module and GIS integration
- Rounding to dollars in budgeting module
- Addition of Projects Vue Module
- Moved Shop Work Order Menu selection under Cost Centers Menu
- Autoloading Old Name, Surface Type and OT rate on Detail record
- Graphics Imaging utilizing WIN 98/200 imaging engine
- Noxious Weed chemical treatment database
- Noxious Weed Library additions (Thanks to U of MT/KS/NJ/MO/FL)
- Additions to Weed Control module and integrated GIS support
- Addition of Kansas Specific Reporting module
- Addition and GIS integration of Maintenance Analysis
- Addition of Project Estimator Module
- Live Budgeting and Actual Costing modules
- Reporting enhancements for Nebraska Reporting module
Version 6.10 (May)
- Migration to Clarion 5a Enterprise Edition Development Environment
- Addition of more comprehensive/flexible Query system
- Addition of Signs GIS
- Addition of Utilities GIS
- Autoloading Road Name, Township Name on Detail record
- Addition of Culverts GIS
- Addition of Simplified Road Management Module/Reporting (SRM)
- Accounts Payable module
Version 6.01 (February)
- Accounts Receivable module
- Addition of Nebraska State reporting module
- Addition of Road/Street Complaints module
Version 6.00 was introduced in January, 1999
- Started development in TopSpeeds Clarion Version 4 (March, 1998)
(Clarion is a C/C++, Object Oriented development environment)
1993 - 1998
Version 5.xx (1997) Windows 3.xx,WIN95,NT 3.51/4.xx and IBM OS/2
Version 4.xx {1996) 32-Bit DOS implementation with GIS support
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Versions 1- 3 (1993 - 1995) 16-Bit DOS implementations
Created with Dr.Explain
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